The Basics

The first page of the gradebook is called the Grader report. This term is sometimes used interchangeably with “grading grid” or “gradebook,” although the latter is better used to describe the entire functional area of a LATTE course.

Grade Item Types

Manual grade items - these items are submitted and graded outside of LATTE. They must be manually added to the gradebook, and scores must be typed directly into the grader report.

Activity-based grade items - these items represent activities that have been added to the course home page. Activities incorporate student interaction, and these items appear automatically in the gradebook. Quizzes and assignments are examples of activities. Grades for these items are generated automatically by the system (multiple choice quiz questions, for example), or entered on the activity’s grading page by the instructor.

Roles

Gradebook setup and maintenance can be managed by users who have the Primary Instructor, Secondary Instructor, or Grading TA role in the course. Users with the course assistant role cannot edit the gradebook or enter student grades. Users with the student role can only view their own, personal user report.

Importing Grades

The gradebook exists in every course, but it is not directly linked to the Brandeis Registrar’s SAGE system, so instructors are not required to use it. Some instructors manage course grades outside of LATTE, especially those with complex grading schemes, with tools like Excel. In these situations the instructor may choose to import their grades into the LATTE gradebook using the import/export function that is built-in to the gradebook. Please click here for more on exporting grades and here for more on importing grades.

Access

To access the gradebook module, first log in to LATTE, open a course, and then click the Grades link from the Administration block or LATTE Course Tools Block.

The Interface

On the grader report you will see a grid containing a row for each enrolled student, and a column for each grade item, as well as columns displaying category point totals. The tabs across the top of the report represent other functional areas of the gradebook, used for setting up the gradebook, and adjusting gradebook settings.

1. View / Grader report - Display of all students and grade items, including calculated totals. Manual grade items are
scored directly in the grid. Sub-tabs within the View tab include the User report, which displays a single student's scores across all grade items.

2. Setup - Manage categories, preferences, and settings here. Sub-tabs within the Setup tab include Categories and items (point H), Course grade settings (point I), and My Preferences (point J).

3. Scales - Edit and create scales here. Scales are commonly used to assess student responses in a standardized way, such as with a Pass/Fail/Incomplete or 5-star scale. Forum post grading requires the use of scales. Scales have a hidden point value, and it is very challenging to combine items that are graded on a scale, with items graded by standard points. More info here: https://docs.moodle.org/28/en/Scales#Example_scales

4. Outcomes - Outcomes are a sub-set of grades, used to assess specific levels of knowledge that are linked to specific learning goals established by the instructor, and often displayed as a series of statements. This is an advanced gradebook function.

5. Letters - Edit letter grades assignments (i.e. 90% and above is an A, 80% and above is a B).

6. Import - Merge the data from an external spreadsheet into the course gradebook.

7. Export - Export data from the course gradebook into a format that can be read by external applications, such as Microsoft Excel.

8. Categories and items - Manage categories, calculation methods, and add manual grade items here. Categories are used as an organizational tool, and also to give you more fine-tuning control over how grades are calculated (i.e. with weighting or extra credit).

9. Course grade settings - Control how the gradebook appears to all participants in the course.

10. My preferences - Control how the gradebook appears to you only. Settings here apply to all gradebooks that you have access to in LATTE.

Workflow and Setup

Every gradebook is unique, but there are a number of common steps that every instructor should follow when preparing a course gradebook. Common points of confusion can be avoided if the steps are followed in sequence!

Plan

The best place to start is the course syllabus, where the course plan is outlined for students. How is a student’s final grade determined? What calculation methods are needed? Are you simply adding up points to calculate final grades, or do you incorporate weighting? Are you offering extra credit? You can edit the calculation methods of a gradebook at any time, but it is much easier to build it correctly from outset.

Hide the Gradebook

If you are building the gradebook in an active course that students are already enrolled in, you may want to hide the entire gradebook from students until you have completed the setup process.

Administration block > Course Utilities > Edit settings > Show gradebook to students > No
Set up categories

Categories are very important to the gradebook. They provide both organizational and functional control over grade items. You may begin by creating a new category for each type of grade item. For example, you could create a category for all course exams, and another for all course assignments.

In this early step, think of categories as folders that help you sort grade items into groups, visually organizing the gradebook.

1. From the Administration block, click the Grades link. The grader report will appear.
2. Click the Setup tab, then the Categories and Items sub-tab.
3. Click the Add category button at the bottom of the table.
4. Name the category.

![Category name](image)

5. Click the Save changes button.
6. Repeat this process for each group of grade items.
7. To change the order of categories, or nest categories within other categories, click the move icon on the left.

![Assignment]

8. Click the empty box that represents the location that you want to move the selected category to.

Note: In more complex grading schemes, categories are used to group grade items for specific calculations. For example, if you want to drop the lowest practice quiz from a student’s gradebook, those practice quizzes must be in their own, separate category! Categories are also used functionally in weighted gradebooks.

Add Grade Items

You will spend much of your course setup time creating the activities that students will interact with on the course home page. You may also need to add manual grade items to fill in certain gaps, for those items that don’t have an online component. It is very important to understand the difference between activities and manual grade items, because they are added to the gradebook, and graded, in different ways.
### Manual grade items

- Added to the gradebook manually, on the Categories and items tab of the gradebook.
- Scoring is done offline, outside of LATTE.
- Scores are typed directly into the grader report.
- Scoring changes are made in the grader report.
- Ex: Participation, clinic work, oral presentations.
- ![Icon](image)

#### “Manual” Grade Items

1. Open the grader report and click the **Setup** tab and **Grade book setup** sub-tab.
2. Click the **Add grade item** button at the bottom of the table.
3. **Name** the item.
4. Set the total point value for this item in the **Maximum grade** box.
5. Select a category from the **Grade category** drop-down menu.
6. Click the **Save changes** button.
7. Repeat this process for each manual grade item in the course.

### Activity-based grade items

- Added to the gradebook automatically, when the activity is created on the course home page.
- Scoring is done in the course, within each activity’s **unique scoring interface**. This can occur automatically (i.e. multiple choice quizzes) or manually (i.e. essay quiz questions, assignments).
- Scores are automatically added to the grader report by the activity.
- Scoring changes are made in the activity.
- Ex: Quizzes, assignments, forums.
- ![Icon](image)

#### “Activity-based” Grade Items

1. Navigate to the course home page.
2. Click the **Turn Editing On** button (top right of page).
3. Click the **Add an activity or resource** link from within a topic area.
4. Choose an **activity** from the list provided. (Resources are not associated with the gradebook.)
5. Click the **Add** button.
6. You will be taken to the **Adding a new...** page, which is different for each type of activity. Provide a **name** and description for the activity.
7. Set up the **grading values** and select the containing category from the gradebook.
8. Each activity has a unique setup process. Please refer to the LTS Knowledge Base [kb.brandeis.edu/display/LTS/Wel come+to+the+LTS+Knowledge+Base](kb.brandeis.edu/display/LTS/Wel come+to+the+LTS+Knowledge+Base) for more information, or contact us.
9. Click the **Save and display** button to create the item and continue to build the activity, or click **Save and return to course** to create the activity and return to the course home page.
10. Repeat this process for each activity-based grade item in the course.
Edit categories

At this point, your gradebook should be populated with most, if not all, of the grade items from your syllabus, and those grade items should be organized into categories. Each graded item’s maximum point value should also be set. You are now ready to setup aggregation methods for each category. This step can be take some time, depending on the complexity of your gradebook, but once complete, your gradebook may only need minor adjustments as you move forward from term to term.

Aggregation Methods - The definition of aggregation is "several things grouped together or considered whole." Aggregation methods in LATTE are the calculations methods used to determine student grade totals. Aggregation methods can be set for the entire gradebook, and for each sub-category.

All of this is controlled on the Categories and items sub-tab in the Setup tab. The available methods include:

- **Mean of grades** - The sum of all grades, divided by the total number of grades. Or, in simple terms, the average of all grades.
- **Weighted mean of grades** - Categories and individual grade items can be assigned a weight value, which determines their overall influence on the final grade.
- **Simple weighted mean of grades** - A way to convert a points-based gradebook into a percentage-based gradebook, this method calculates the weight for you as the max grade minus the minimum grade. Or, in simple terms, this method allows you to edit the category totals field (often used to change total from a random sum of points, to an even 100).
- **Median of grades** - The middle grade when grades are arranged in order of size.
- **Lowest grade** - Only the lowest grade is used.
- **Highest grade** - Only the highest grade is used.
- **Mode of grades** - The grade that occurs the most frequently.
- **Natural Weighting** - Natural weighting can produce either a sum or a mean, with or without weights, depending on instructor needs. As such, natural weighting serves as a single aggregation method that can supercede sum of grades, mean of grades (with or without extra credit), and both weighted mean and simple weighted mean of grades.

Note: * marks most commonly used aggregation methods.
Setting the aggregation method for a category:

1. Open the grader report and click the Categories and items tab.
2. Click Edit and then Edit Settings in the Action Column of a category. From the Aggregation drop-down menu, select a method.
3. To access advanced options of the category, click on the Show More link.
4. Click the Save changes button at the bottom of the page.

Additional Notes:

- **Settings** - adjust settings for that item.

- **Show/Hide** - hide the grade item from students on their user report. This *does not* hide activities from the course home page, it only hides the grade.

- **Delete** - removes item from gradebook. Manual grade items can be deleted here. Activity-based grade items can only be removed on the course home page. If you delete a category, the grade items within are not deleted.

- **Move item** to another location within the categories and items table.

Settings and preferences

There are two pages in the gradebook module that allow you to adjust the gradebook display; Course Grade Settings, and My preferences. Course grade settings and preferences *do not* affect how grades are calculated. Just remember to click the Save changes button anytime you make a change to a default setting!
Course Grade Settings

Changes affect all course participants’ view of the gradebook, including course editors and students.

General and Grade item settings affect the overall gradebook. Overview report settings affect the grader report that course editors see. User report settings affect the report that students see.

Grade display type - Choose the format of the grade totals. For example A/B/C (letter), points, or a percentage.

Overall decimal points - Set how many decimal points display on the grader report. Does not affect calculations, which use up to 5 decimal points.

Hide totals if they contain hidden items - Hides category totals from students, if a grade item within that category is hidden. This prevents students from figuring out what grade they may have received on a hidden item, before course editors release it to the class.

My Preferences: Grader report

Changes affect only your view of the gradebook. Also note that preferences apply to all of your course gradebooks across LATTE.

Show show/hide icons - Visible by default, the show/hide icon (looks like an eyeball) allow a course editor to show or hide an entire grade item's user reports.

Show locks - One handy feature of the gradebook is the ability to grade item, preventing it from being updated manually or by the activity it's contained within. Locks are hidden by default.

Show quick feedback - Adds a feedback box to the grader report. a course editor to quickly add a short comment for the student about grade item.

Students per page - Tired of all the vertical scrolling? Lessen the students per page on the grader report. 15 is a good number to try!

Un-hide gradebook

If you previously hid the gradebook, as suggested by this how-to article, you are now ready to show the gradebook to students! This is done on the course Edit settings page.

You can make grades visible by:
1. Looking for the administration block on your LATTE course page
2. Looking within the block for “course utilities” (it should be the first topic)
3. Clicking on “edit settings”
4. Scrolling down to the “appearance” setting
5. Looking for “show gradebook to students”
6. Selecting “yes”

Administration block > Course Utilities > Edit Settings > Appearance > Show gradebook to students > Yes

Not sure what a setting does, exactly? Click the adjacent help icon to pop-open a help box.
Enter grades

There are three methods for entering student grades into the gradebook; (1) entering grades directly into the grader report, (2) entering grades into an activity, and (3) importing grades from a spreadsheet. These methods are very different, and dependent on how the grade item was created.

Method 1 - Enter manual grades:

For all grade items that were manually added to the gradebook, you must enter those grades directly into the grader report. This is the only place in the course that you can access these grades. You are free to edit these grades at any time, because they are not directly linked to activities on the course home page.

1. Verify that you are on the View tab of the grader report.
2. Click the Turn editing on button.
3. Click into a box, and type a value.
4. Press the tab key or click into the next cell, and repeat for each grade.
5. Click the Save changes button.

Method 2 - Enter activity-based grades:

Grades items based on an activity (quizzes, assignments) are automatically added to the gradebook when the activity was created. You will enter these grades on the individual activity’s grading page, not directly on the grader report. If you fail to follow this rule, you will override grades being calculated by the activity.

Since each activity is different, we cannot address each process in this document. Please find the contact and resources links provided at the end of this document for more information and assistance.

Method 3 - Import grades

If you are calculating your grades outside of LATTE, you can import them into the gradebook to make them visible to students. The process involves a number of steps.

Transfer grades

The LATTE gradebook is not linked to the Registrars Office. Therefore, course instructors must copy all final student grades into SAGE [sage.brandeis.edu]. Please refer to your department support staff for help with this process.

User Report

The User report is an often overlooked, but extremely useful part of the gradebook module. It allows course editors to see the gradebook from the student's perspective. You can view a generic user report, or specific student's report.

Open the gradebook, and select User report from the row of tabs.

Once in the User report, you can select a specific student's report from the Select all or one user drop-down menu.
LATTE provides the ability to import and export grades in a variety of formats. The most popular method involves using Microsoft Excel and the CSV file format (comma separated value). The process allows you to freely move grades in and out of the gradebook, using the email address field to sync your data.

Why would you want to do this? There are a few possible reasons. The most common is that you have a complex grading scheme that the LATTE gradebook simply cannot accommodate. Or you may collect grades from multiple systems, and need to combine them in a larger spreadsheet to perform your calculations.

Before you attempt this process, there are a few key points to be aware of:

- You should wait until all students are enrolled in the course before performing an export of the gradebook.
- If you import any activity-based grade items from a file, you will override the grades that the activity may be generating, and break the link between the gradebook and the activity.
- Even if you don’t intend to move grades in/out of the LATTE gradebook for any reason, it’s important to understand the export process, because exporting is the best way to backup student grades!
- LATTE cannot import Excel files directly, they must be exported, or “saved as” the CSV file format.

**Export gradebook:**

1. Click the Export tab in the gradebook.
2. Click the Excel spreadsheet link.
3. If you want to include columns for entering feedback, check the “Include feedback in export” box.
4. Choose which grade items to export, by selecting the corresponding check boxes.
5. Click the Submit button.
6. On the preview page that appears, click the Download button to save the file to your local computer.

For more information on exporting grades using the gradebook, please click [here](#).

**Import back into LATTE, selecting specific fields to import**

**Update grades in Excel and create CSV file:**
(Steps provided below apply to the PC version of Excel)

1. Open the exported spreadsheet with Microsoft Excel.
2. If necessary, combine the gradebook data with another spreadsheet, aligning data by the email address field.
3. Enter and calculate grades.
4. Click on the File tab, and choose Save as.
5. From the Save as type drop-down menu, choose CSV.
6. Click the Save button.
7. Close Excel.

Import into the LATTE gradebook:

1. Click the Import tab in your LATTE gradebook.
2. Verify that the CSV file sub-tab is selected (not XML file).
3. Drag-and-drop the CSV file (not the Excel file) into the import file upload box. It will take a few moments for the upload to complete.
4. Leave the options at their default settings, and click the Upload grades button.
5. The Import preview page will appear.
6. In the Identify user by group:
   Map from - select email address.
   Map to - select email address.
7. In the Grade item mappings group, select which grades items to import:
   The labels on the left are columns from the CSV file.
   The boxes on the right are columns in LATTE gradebook. If you do not wish to import a column, leave its corresponding drop-down menu set to ignore.
   Select New grade item if the item does not yet exist in the LATTE gradebook.
8. Click the Upload grades button.
9. You should receive a Grade import success message, click Continue to complete the process!

For more information on importing grades, please see here.

**Tips and Tricks**

The LATTE gradebook is powerful and complex. These tips will help you work more efficiently and avoid common pitfalls.

a. **Avoid nuanced grading schemes:**
   If the LATTE gradebook's tools cannot manage your grading scheme, that may be a sign that it is time to simplify your syllabus! Complexity and exceptions to grading rules only lead to a confused group of students, and require extra time for instructors and (support staff) to manage.

b. **Overwriting grades during import:**
   When you import grades for a manual grade item, you will overwrite all grades in that column of the LATTE gradebook. While this effect may be desired, note that there is no undo option in the gradebook!

c. **Overriding grades on the grader report:**
   Updating an activity-based grade item directly on the grader report will break the link between the gradebook and the activity. The cell will become highlighted in yellow, as a visual cue. Overrides also occur if you import grades from a CSV file for activities, which causes the entire column to be overridden and highlighted in yellow.

   To remove an override, (1) click the settings icon on the overridden grade item, (2) un-check the Overridden check box, (3)
delete the value in the Final grade text field, and then (4) click the Save changes button. Repeat for each overridden item.

d. **Locking grades:**

When updating grades directly on the grader report, you can protect adjacent columns to prevent accidental grade updates. Click the *settings icon* at the top of the column, then tick the *Locked* check box to lock all items in the column.

*However, note that if you lock activity-based grade items, you are also preventing the activity from applying any further updates to that item in the gradebook!*

e. **Hiding grade items:**

If a column in the gradebook is “greyed-out,” that grade is hidden from students. Click the *show/hide* icon on either the grader report or the *Categories and items* tab to hide an item.

f. **Hiding quiz grades:**

The *show/hide* icon is not available for quizzes in the gradebook. Instead, you must open the *Edit Settings > Review options* area of a quiz to show/hide points from students.
g. **Backing up your gradebook:**
   The grade export process is also very useful for creating a **backup copy of your gradebook**, even if you do not plan on calculating grades in Excel and importing them back in to LATTE.

h. **Navigating the grader report:**
   Click the up/down arrows in the column header to sort the table in ascending or descending order.

![Lab assignment #1](image)

Additional resources from Moodle.org:
- https://docs.moodle.org/28/en/Gradebook
- http://docs.moodle.org/28/en/Grades_FAQ
- http://docs.moodle.org/28/en/Category_aggregation

Need additional help? Contact an Academic Tech Specialist. We are available by appointment, and we also offer workshops.
Website - latte.brandeis.edu
Workshops - its.brandeis.edu/courses/newlatte/about/workshops.html
Email - latte@brandeis.edu
Phone - 781.736.HELP

**Related articles**

- Adding TAs and Guests
- Using the Gradebook
- Text Editing
- Google Groups
- Create Online Assignments

- The Interface
- Set up categories
- Add Grade Items
- “Activity-based” Grade Items
- Edit categories
- Un-hide gradebook
- User Report
- Import/Export Grades
- Tips and Tricks
- Related articles